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USE IN LIFE SUPPORT DEVICES OR SYSTEMS MUST BE EXPRESSLY AUTHORIZED.

STMicroelectronics PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN 
LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF STMi-
croelectronics. As used herein:

1.Life support devices or systems are those 
which (a) are intended for surgical implant into 
the body, or (b) support or sustain life, and whose 
failure to perform, when properly used in accord-
ance with instructions for use provided with the 
product, can be reasonably expected to result in 
significant injury to the user.

2. A critical component is any component of a life 
support device or system whose failure to per-
form can reasonably be expected to cause the 
failure of the life support device or system, or to 
affect its safety or effectiveness. 
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EVALUATION KIT
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Rev. 1.0

INTRODUCTION

A microcontroller is needed for communication in DALI dimmable ballast applications. A com-
munication protocol and the interface parameters have been defined by the leading manufac-
turers of lighting equipment. This interface is currently in the process of international standard-
ization and will be included in Annex E of the IEC929/ EN60929 international standard for
electronic ballast performance requirements. The draft of the standard can be obtained from
the standard documentation institutions in the same way as other IEC documentation.

For more information about DALI, visit the information platform at http://www.dali-ag.org/

STMicroelectronics offers a dedicated ST7DALI microcontroller in its standard 8-bit ST7 micro
family, and fully documented free software in ANSI-C, which is fully compliant with this
standard (Annex E.4). The corresponding test procedure (Annex G) has been followed to val-
idate the compliance. The software is described in application note AN1601.

This evaluation kit allows you to evaluate the STMicroelectronics solution.

As a first step, from a master board connected by RS232 to a user-friendly PC software, you
can send DALI commands to the DALI slave boards and see the action on the light (or on
yellow LED).

Then, when you start a design, you can consider the slave board itself, hardware and soft-
ware, as a reference design for a DALI gateway topology.

Figure 1. ST7DALI-EVAL Evaluation Kit
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KIT CHECKLIST
1 KIT CHECKLIST

The ST7DALI-EVAL evaluation kit contains the following items:

1 CD-ROM

1 Master board

2 Slave boards

1 4-wire cable (12V supply + DALI bus)

1 RS232 DB9 null-modem cable

1 AC/DC adaptor (13.5V DC 600mA)
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HARDWARE FEATURES
2 HARDWARE FEATURES

2.1 DALI SLAVE BOARD

ST7DALI flash microcontroller with DALI communication module

1-10V output (standard dimmable ballast input)

DALI communication interface (This interface passes the IEC standard 60929 “Physical oper-
ational parameters” test sequences).

12V supply connector.

No need for an external resonator, ST7FDALI has an internal 1% RC oscillator

The 12V power for the board is supplied from the master board. An LD2980 linear voltage reg-
ulator converts to 5V. The board outputs an analog signal between 1 to 10V to control a
standard dimmable ballast.

J1 Input connector: 12V, 0V, DALI1, DALI2

J2 output connector: 0-10V

Green and red LEDs: indicate if the slave was addressed by the last command or not

Yellow LED: Displays the 1-10V output level

2.2 MASTER BOARD

DALI communication interface

RS232 communication interface

AC/DC adaptor input

J1 Output connector: 0V, 12V, DALI1, DALI2

P1 Input/output connector: RS232

Green and red LEDs:

Limitation:

The master board power supply does not fully meet the DALI bus specification. It has been de-
signed especially for this evaluation kit, to be connected to 2 slave boards only. The function-
ality is not guaranteed if more slaves are connected to the bus.
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GETTING STARTED
3 GETTING STARTED

3.1 PC SOFTWARE INSTALLATION

The PC software runs under Win NT, Win 2000, Win98 & Win95

Run the Setup.exe file on the CD-ROM. And follow the indications.

3.2 MICROCONTROLLER SOFTWARE

ST72C334 (master board) and ST7DALI (slave board) are already programmed.

3.3 CONNECTING THE BOARDS

Connect both slave boards and the master boards with the 4-wire cable

You can optionally connect a dimmable ballast, with a standard 1-10V input, to each slave
board to run the demo (not provided with this evaluation kit). Otherwise, a yellow LED on the
slave board allows you to see a corresponding change in the level of the lamp.

Connect the master board to the PC serial port with the RS232 null-modem cable

Connect the AC/DC adaptor to the master board

Plug the AC/DC adaptor on the mains. Important note: after this operation, send a Full
Search command (Select “Extras” menu, item “Search for Ballasts…”.) and a Quick Search
command (Select “Extras” menu, item “Search for Ballasts…”.). 

3.4 RUNNING THE PC SOFTWARE

On the PC, run “PowerControl” in Start/Programs/ST7Dali.

The user interface consists of a main window and 5 other windows. The main window is al-
ways visible.

Select “View” menu to choose other visible windows.

Figure 2. Main window
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GETTING STARTED
Windows:

Ballast Grid window: ballasts found on the bus after a Search

Light Level Slider window: buttons and sliders for adjusting light level parameters

Selection window: Buttons for selecting groups

Scene window: buttons for selecting scenes

DALI logger window: displays all DALI commands sent

3.5 BASIC COMMANDS

3.5.1 Addressing the ballasts

Select “Extras” menu, item “Search for Ballasts…”.

The following window appears:

Figure 3. Figure 3: Search for Ballast window

Run a “Full Search”. When it is finished, run a “Quick Search”.

The master will find two ballasts on the network. The ballast window shows these ballasts.

See Section 4.1 Addressing ballasts for more details on this topic.
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GETTING STARTED
Figure 4. Screen overview after a Quick Search

3.5.2 Light level

You can choose to change the light level of only selected ballasts or all ballast by pushing ei-
ther the “Selected” or the “All” buttons in the “Light Level” Window.

You can change the light level by pushing the up “>>” and down “<<” buttons, or by moving the
slider.

Figure 5. Light Level window

Ballasts change the light level immediately. Push the “Update” button in the “Ballasts” window
to update all the ballast light level in the “Ballasts” window. To do so, the master asks each bal-
12/32



GETTING STARTED
last on the network its actual level (QUERY ACTUAL LEVEL command). The colors in the
“Ballast” window represent the light level (black for 0%, yellow for 100%).

Figure 6. Ballasts window after clicking on Update
13/32



PC SOFTWARE FEATURES
4 PC SOFTWARE FEATURES

4.1 ADDRESSING BALLASTS

4.1.1 Full Search

A “Full Search” is an example of address allocation to be done after a DALI system installa-
tion. Each ballast (up to 64) must have a short address.

The procedure is the following:

To start the algorithm, the master sends the INITIALIZE command

The master sends the RANDOMIZE command to make each ballast generate a 24-bit random
number

The master searches the ballast with the lowest random number (SEARCHADDRH, SEAR-
CHADDRM, SEARCHADDRL, COMPARE commands) and a short address (6-bit) is as-
signed to this ballast (PROGRAM SHORT ADRESS command). This ballast stores this short
address in the ST7DALI E²PROM.

The programmed short address is verified (VERIFY SHORT ADDRESS command)

This ballast is removed from the search process (WITHDRAW command)

This procedure is repeated until all ballasts have a short address. The process is stopped by
the TERMINATE command.

If two or more ballasts have the same short address, the addressing procedure is restarted
only for these ballasts with the INITIALIZE command.

All the successive commands are displayed in the DALI logger window.

From now, every ballast on the network has a short address, stored in the microcontroller`s
E²PROM.

4.1.2 Quick Search

A “Quick Search” searches ballasts with a short address, connected on the DALI bus. The
master uses the QUERY BALLAST command.

4.2 SIMULATE FADING

This operation is done by pushing the “Simulate Fading” button in the “Slider” window.

Fade time and fade rate parameters can be adjusted by sliders. Push the “Apply” button to val-
idate the modifications.

The fading can be done either on “All” or “Selected” ballasts.
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PC SOFTWARE FEATURES
The target light level is chosen by moving the slider with the mouse. The simulation will begin
as soon as you release the left mouse button, taking into account the Fade time and Fade rate
parameters.

4.3 CONFIGURATION

Select “Options” menu, item “Configuration…”

The following window appears:

Figure 7. Configuration window

Choose if you want the following action to apply to “All” or only “Selected” ballasts by pushing
the right button at the top of the window.

4.3.1 Storing a Group

Choose the number x of the group you want to create with the combo. Push the “OK” button
to define the group number x.

The group’s name can be customized by selecting the “Option” menu, item “Change group
names…”
15/32



PC SOFTWARE FEATURES
Figure 8. Names of groups

4.3.2 Storing a Scene

Choose the number x of the scene you want to create with the combo. By pushing the “OK”
button, the actual light level of selected or all ballasts will be stored as Scene number x. The
master makes each addressed ballast storing the actual level as its scene x level.

The scene name can be customized by selecting the “Option” menu, item “Change scene
names…”
16/32



PC SOFTWARE FEATURES
Figure 9. Names of scenes

4.4 ADDRESSING COMMANDS TO A GROUP

Select a group by pushing the corresponding button in the “Groups” window.
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PC SOFTWARE FEATURES
Figure 10. Group window

4.5 CALLING BACK A SCENE

A scene can be called back by pushing the corresponding button in the “Scene” window. The
master sends a GO TO SCENE, and a QUERY ACTUAL LEVEL command to every ballast.
Each ballast outputs the level corresponding to this scene, previously stored in the microcon-
troller`s E²PROM.
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PC SOFTWARE FEATURES
Figure 11. Scene window

4.6 MANUAL DALI INTERFACE

Select the “Options” menu, item “Send DALI command…”

The following window appears:
19/32



PC SOFTWARE FEATURES
Figure 12. Manual DALI interface window

4.6.1 Automatic Command

An “Automatic” command can be sent by choosing a command in the “Command” combo box.
All DALI commands defined in the EN60929 are available (See summary of the command set
in draft, section E.4.3.5).

The second combo box allows the recipient(s) to be chosen:

Broadcast: all ballasts connected on the DALI bus

Group xx: all ballasts in the xx group (xx between 0 and 15)

Short yy: ballast with the short address yy (yy between 0 and 63)

The third combo box is the data associated with the command. This parameter can be irrele-
vant, depending on the command. But it always needs to be filled out.

If the command is a “Query” command, the answer of the ballast addressed is displayed at the
bottom of the window. (If the query is addressed to more then 1 ballast, an error occurred)

Example:

In the following window, a push on the “Send” button will put the light level of the ballast which
has the short address 3 to a level of 11.
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Figure 13. Light Level window

4.6.2 Manual Command

In this way the user has to fill the 2 bytes. Refer to EN60929 to know command codes.

4.7 RUN AUTOMATED DEMO

Select the “Extras” menu, item “Run automated demo”.

The following window appears:

Figure 14. Automated demo configuration window
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PC SOFTWARE FEATURES
Set the timer interval x and the last defined scene y.

Push the “RUN” button to start the demo.

The master will go from Scene 0 to Scene y, and then restart from Scene0, with an interval of
x milliseconds between each.

4.8 SAVE/LOAD CONFIGURATION

Select the “File” menu, item “Save…” to save the actual configuration.

Select the “File” menu, item “Load…” to load a configuration.
22/32
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5 DALI SLAVE BOARD FEATURES

5.1 LEDS

5.1.1 Green and red LEDs

The green or red LED on each slave board indicates if the board was addressed or not by the
last command sent by the master.

For example, if you select both ballasts before changing the light level, the green LED will be
switched on both slave boards. On the other hand, if you select only one ballast before
sending a command, the green LED will be switched only on one addressed slave, and the red
LED will be switched only on the slave that is not concerned by the command.

5.1.2 Yellow LED

The yellow led displays the 1-10V output level corresponding to the light level. It is especially
useful if you do not want to connect a ballast to the 1-10V output.

5.2 JUMPER

This jumper allows you to measure the ST7DALI microcontroller current consumption (partic-
ularly in halt mode).
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DALI SLAVE BOARD FEATURES
5.3 DALI INTERFACE

5.4 ST7DALI SOFTWARE

The software is compliant with Annex E of the IEC929/ EN60929 standard.

A tester performing all the tests defined in Annex G of the standard has been used to validate
the ST7DALI DALI software.

Refer to AN1601 for a description

5.5 HALT MODE

The ST7DALI-EVAL evaluation board can be used to measure the extremely low consumption
of the microcontroller in Halt mode, by measuring the voltage on jumper 4.
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DALI SLAVE BOARD FEATURES
5.6 SOFTWARE DESCRIPTION

The DALI slave software is described in AN1601.

Source code and environment setup files for STVP7 are included in the CD-ROM.

The software can be compiled with both Cosmic and Metrowerks compilers.

5.7 REPROGRAMMING THE MICROCONTROLLER

The microcontroller can be reprogrammed through the ICP connector using:

STMicroelectronics ST7 Flash STICK

Softec InDART ST7F/D (www.softecmicro.com)

5.8 DEBUGGING THE APPLICATION

The user can debug in two different ways:

- Emulation using a ST7MDT10-EMU3 (in this case, solder a DIP20 to SO20 device adaptor/
socket onto the board. See ST7MDT10-EMU3 Probe User Guide, section 3.6).

- In circuit debugging with a Softec InDART ST7F/D (www.softecmicro.com).

5.9 USEFUL DOCUMENTATION

Related documents are: 

AN1601 - Software Implementation for ST7DALI-EVAL

AN1756 - Choosing a DALI Implementation Strategy with ST7DALI

AN1900 - Hardware Implementation for ST7DALI-EVAL
25/32
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6 APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL

6.1 DALI GATEWAY SLAVE BOARD

6.1.1 Slave board Schematics

6.1.2 Slave Board Bill of material

Item Qty Reference Value Voltage % Footprint Description Ref RS

1 2 C2, C3 1uF 20V 10% 3216 Tantalium
262-
4327

2 4 C1,C4,C5,C6 100nF 50V 10% 0805 X7R
264-
4416

3 1 C7 22uF 20V 10% 6032 Tantalium
262-
4636

4 2 R1, R2 2K49 1/4w 0.1% 0805 Resistor
215-
2850

5 1 R6 3K3 1/4w 1% 0805 Resistor
223-
0499

6 1 R3 82K5 1/4w 0.1% 0805 Resistor
215-
4525

7 3 R4,R5,R12 10K 1/4w 1% 0805 Resistor
223-
0562

8 2 R7,R8 0 1/4w 1% 0805 Resistor
223-
0146

9 1 R9 11K 1/4w 0.1% 0805 Resistor
215-
3544
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APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL
10 1 R10 332R 1/4w 0.1% 0805 Resistor
215-
1914

11 1 R11 4R7 1/4w 1% 0805 Resistor
344-
6279

12 1 R13 1K21 1/4w 0.1% 0805 Resistor
215-
2513

13 1 R14 3K16 1/4w 0.1% 0805 Resistor
215-
2951

14 1 R15 150K 1/4W 1% 0805 Resistor
223-
0714

15 1 R16 4K7 1/4w 1% 0805 Resistor
223-
0528

16 1 LD1 HSMS-C670HE 0805 Red Led CMS 2mA 429-546
17 1 LD2 HSMG-C670 0805 Green Led CMS 2mA 429-568
18 1 LD3 LYT670 Yellow Led 428-830
19 1 D4 MB2S Bridge Diode 269-366

20 1 D5 BZX284C2V7 0805 Zener 2.7V
216-
9599

21 1 D6 BAS-16 SOT23 Diode
436-
7773

22 1 U2 TS271CD SO8 Operational amplifier STM

23 1 U3
ST7FDALIF2M

6
SO20 Micro STM

24 2 U4, U5 SFH6156-2 SO4
Optoisolator output 

NPN Transistor Input 
DC

284-
1190

25 1 U6
LD2980ABU50

TR
SOT89

ULTRA LOW DROP 
VOLTAGE REGULA-

TORS
STM

26 1 Q1 BC817-25 SOT23 NPN Transistor STM

27 1 J1 MC 1,5/4-G Connect
Connector, PCB, 

header, 3.81mm pitch, 
4 way

220-
4850

28 1 J2 MC 1,5/2-G Connect
Connector, PCB, 

header, 3.81mm pitch, 
2 way

220-
4822

29 1 J4 Connect Current Sense
251-
8086

30 1 J3 Connector Connect
Connr, rect, header, 
IDC, low profile box, 

straight mount, 10 way

120-
7230

Item Qty Reference Value Voltage % Footprint Description Ref RS
27/32
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APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL
6.2 DALI MASTER BOARD

6.2.1 Master Board Schematics

31 1 Connector Connect

Connector, PCB, 
screw terminal, cable 
mount, 3.81mm pitch 

2 way

220-
4658

32 1 Connector Connect  jumper link 334-561

Item Qty Reference Value Voltage % Footprint Description Ref RS
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APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL
6.2.2 Master Board Bill of material

Item Qty Reference Value Voltage %
Foot 
print

Description Ref RS

1 7
C1,C2,C3,C5,C6,

C7,C13
100nF 50V 10% 0805 Capacitor Type X7R

264-
4416

2 1 C4 220nF 50V 10% 0805 Capacitor Type X7R
264-
4438

3 3 C8, C9, C11 1uF 20V 10%
custom-

er
Tantalium Capacitor

262-
4327

4 1 C14 22uF 20 10%
custom-

er
Tantalium Capacitor

262-
4636

5 2 R1,R5 0 1% 0805 Resistor
223-
0146

6 1 R2 220 1/2W 5% RC05 Resistor 132-337

7 2 R3,R4 10K 0.1W 1% 0805 Resistor
223-
0562

8 1 R6 11K 0.1W 0.1% 0805 Resistor
215-
3544

9 2 R7,R8 2K49 0.1W 0.1% 0805 Resistor
215-
2850

10 1 R9 1K21 0.1W .1% 0805 Resistor
215-
2513

11 1 R10 332R 0.1W .1% 0805 Resistor
215-
1914

12 1 R11 4R7 0.1W .1% 0805 Resistor
344-
6279

13 1 R12 3K16 0.1W .1% 0805 Resistor
215-
2951

14 1 R15 4K7 0.1W 1% 0805 Resistor
223-
0528

15 1 D1
BZX85C2

2
22V DO41 Diode Zener 812-544

16 1 D2 MB2S 200V
TO-

269AA
BRIDGE SMD 269-366

17 1 LD3
HSMG-

C670 HE
0805 Red Led SMD 429-546

18 1 LD4
HSMG-
C670

0805 Green Led SMD 429-568

19 D5
BZ84C2V

7
2.7V 0805 Diode Zener

216-
9599

20 1 D6,D7 BAS16 SOT23 Diode 
436-
7773
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APPENDIX: BOARD SCHEMATICS AND BILLS OF MATERIAL
21 1 X1
CSA16.0
0MXZA04

0

Murata 16Mhz (or 
CST16.00MXWA0C3 or 
CSACV16.00MXA040Q

or 
CSTCV16.00MXA0H3Q)

179-
3810

22 1 Q1
BC817-

25
SOT23 NPN Transistor STM

23 1 U1
ST7202C

D
SO16

RS-232 DRIVERS AND 
RECEIVERS

STM

24 1 U2
ST72C33

4J4B6
SDIP42 Micro STM

25 1 U3,U4
SFH6156

-2
SO4 Opto-isolator

284-
1190

26 1 U5

KF120BD
T/ 

L78M15C
DT

DPAK
VERY LOW DROP VOLT-

AGE REGULATORS
STM

27 1 U6
LD2980A
BU50TR

SOT89
ULTRA LOW DROP VOLT-

AGE REGULATORS
STM

28 1 J1
Connec-

tor
Connector, PCB, header, 

3.81mm pitch, 4 way
220-
4850

29 1 J2 Jack PCB socket 2.5mm
286-
8763

30 1 J4
Connec-

tor

Connr, rect, header, IDC, 
low profile box, straight 

mount, 10 way

120-
7230

31 1 P1 RS232 RS 232 SOCKET for PCB 457-484
32 4-wire cable, terminated with three Connectors for cable mounting RS code 220-4670

Item Qty Reference Value Voltage %
Foot 
print

Description Ref RS
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“THE PRESENT NOTE WHICH IS FOR GUIDANCE ONLY AIMS AT PROVIDING CUSTOMERS WITH INFORMATION
REGARDING THEIR PRODUCTS IN ORDER FOR THEM TO SAVE TIME. AS A RESULT, STMICROELECTRONICS
SHALL NOT BE HELD LIABLE FOR ANY DIRECT, INDIRECT OR CONSEQUENTIAL DAMAGES WITH RESPECT TO
ANY CLAIMS ARISING FROM THE CONTENT OF SUCH A NOTE AND/OR THE USE MADE BY CUSTOMERS OF
THE INFORMATION CONTAINED HEREIN IN CONNECTION WITH THEIR PRODUCTS.”

Information furnished is believed to be accurate and reliable. However, STMicroelectronics assumes no responsibility for the consequences
of use of such information nor for any infringement of patents or other rights of third parties which may result from its use. No license is granted
by implication or otherwise under any patent or patent rights of STMicroelectronics. Specifications mentioned in this publication are subject
to change without notice. This publication supersedes and replaces all information previously supplied. STMicroelectronics products are not
authorized for use as critical components in life support devices or systems without express written approval of STMicroelectronics.

The ST logo is a registered trademark of STMicroelectronics.

All other names are the property of their respective owners
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